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InRoads "Athens” Project
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“"Athens”
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e Infrastructure

"Athens is the integrated, interoperable software portfolio for
infrastructure professionals.™
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Infrastructure: the Interface Between
People and our Planet
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Bentley: Sustaining Infrastructure

Our mission is to

provide solutions to
Design — Build — Operate
the world’s infrastructure
with the goal of:

e Sustaining our society
e Sustaining the environment
e Sustaining the profession
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Communities Discover Anytime,
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Connect and Communicate with with Bentley LEARN

7,000+ Members of the Wortld's August/September 2008 -
Infraztructure Community. Amsterdam - Urban |slands,
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Bentley InRoads V8i
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InRoads "Athens” Time Frame

e Target Date Q4 '08
e Simultaneous Software Portfolio Release

The "Athens” software portfolio is "the
most eagerly anticipated portfolio software
update since the V8 Generation began.”
Bhupinder Singh, Senior VP Bentley
Software
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InRoads Release Update

BENTLEY SELECT

MAXIMIZING PRODUCTIVITY OF SOFTWARE, PEOPLE AND INFORMATION

e Continued Investment

e InRoads XM SP3
e Scheduled Q1 2009

\ XM edition
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Summary

e Over 200 Enhancements

e 250 Defects Fixed

e Delivery Includes:
— Civil Track GPS
— Civil Accudraw
- Roundabouts

e I[nRoads Readme

CUnlme Information™

o InFEoads Group Information

o Eentley Eal Traclk Information
Bentley Online Documentation

o Techucal Information

entley InRoads Group ¥8i ReadMe = [=]

o ® @
Hide: Back Forward  Step

BE Communities

LI
Refiesh  Print

Search | Favorfes |

Tupe in the keyword to find:

[
List Topics

Select Topic o display

Dicplay

Bentley Library
s« EBentley SELECT
Bentley Froducts

ILocal Informatio

tley InRoads Group V8i
on 08.11.05

#7205 Group is the central design selution on many major civil engineering and transportation projects. Powerful and versatile, the
roup is used 10 address a broad array of civil engineering needs, fram rapid evaluation of impacts during preliminary phases to final
& and plans preduction.

o Product B

Online Information* Powerful regression analysis combined with the unique element design capability of InRoads Group gives users the power to resolve complex

design geometry efiiciently and accurately in accordance with unique engineering design criteria. & unique Roadway Designer allows
« InRoads Group Information interactive design and review in & synchronized viewing smironment
+ Bentloy Rail Track Information
« Bentley Online Documentation
« Technical Information

« BE Communtics

+ Eentley Library

« Bentley SELECT

o Bentley Products

Along with roads and highways, InReads Graup applications are put to use on a host of engineering projects, including railways, municipal
and public works projects, commercial and industrial sites, levees, canals and rivers, pipelines, environmental projects and more. Users can
improve productivity and accuracy with focused yet integrated applications

The InRoads Group runs seamlessly with Bentley's project collaboration software servers, enabling users to achieve a fully managed

PrajectiWise gives InRoads Group users the security to store, distribute, track, and manage InRoads Group data across unlimited users,
offices, project team members, and locations. Employing InRoads Group and Projectyiss with Digital InterPlot for plotting and publishing,
users reap the bensfits of a world-class solution for project collaboration

* - requires access to the Internet

Last updated September 8, 2008

©2008 Bentley Systems, Incoporated, Legal Notise

v08.11.05
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» Support for distributed rends =
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& ore Information an Micros
RlcroStation Ya xM Edition (w028
e e

Important Informa
Edition (v08.09.04.§

MicroStation ¥8 XM Edition So

o |ocal Information

MicroStation W8 %M Edition w03,

o YWhat is Mew & Changed
%M Edition Software Prerequisit) s Requirements
its installation, vou need to insty  + Quickinstall Guide
¥08.09,04.xx before installing M 3 Feahe
installed a previous version of | 5Guc actiation

o Copyright

e Online Infarmation®

Microstation Information
Bentley Online Documentation
Technical Information

Groups
Bentley Library
Bentley SELECT

w15.059.04

FileSize Certified On

Windows 2000Windows

InRoads "Athens” Readme on Select

=101 ]
Al

MICROSTATION V8

. XM edition

o

What is New & Changed in MicroStation

v08.09.04

The following outling identifies new features and enhancements in this release of
: MicroStation %8 kM Edition.

© Far more infarmation abaut what's newy, see "What's Mew?" = "New in SELECT Update #2" in the online

BN S Talar Dl st help document. To open the help document in MicroStation choose Help = Contents.

e AutoCAD Interoperability
o AutoCAD 2008 DWG support
o Configuration vaniables for all settings in OWG Open/Save As dialog
o Conceptual Modeling Tools Enhancements LI

[ BT S - PR E B SEPETORNE, O
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“Peaceful Coexistence”

Mike’s 2007 definition:

1.The ability for multiple versions of InRoads to
reside on the same machine and work peacefully
without interfering with the other version(s).

2. Bottom line: The ability for you to begin
moving to the next version of InRoads and keep
using the previous version for your “projects in

the pipeline”.
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“Peaceful Coexistence”

Mike’s 286+ 2008 definition:

1.The ability for multiple versions of IrReads
Bentley Civil software to reside on the same
machine and work peacefully without interfering
with the other version(s).

2. Bottom line: The ability for you to begin
moving to the next version of InReads Bentley
Software and keep using the previous version
for your “projects in the pipeline”.
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InRoads "Athens” General Enhancements

e CAD Platforms Supported:
— MicroStation “"Athens”
— AutoCad 2008/2009

e Support for ProjectWise “"Athens”

**With MicroStation “"Athens” _ x|
= '&'\I;.T;blljel.;tfurm | Y erzion |
e DTM Memory Allocation I Corcel_|
- Larger & Faster
— Use of 3GB Switch
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Civil Enhancements

@@

e Roundabouts

e Civil Accudraw
— Distance /Directio

— Distance/Distance
— Station/Offset

e Civil Track GPS

= I5-Small Libranwithfeatures
i

- 521.1002m
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.
InRoads “"Athens”

e DD Converter

— C:\Program Files\Bentley\InRoads Group
V8.11\bin\ldd\UILauncher.exe

il %

Choose project and output paths E -Benﬂeg

LDD praject path: I _I
Output falder: I _I
< Back fewt = |
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Geometry Enhancements

e User Interface Improvements

1: Yertical Change In Plan I ] 3
ST

— Lo — e i

.--':'lul'iew Closed Areas =101 %]
e -
.- Curve Set Annotation = X Filter. . |

::'ul'iew Stationing ;Iglﬂ

5 Wiew Stationing Data:
General | Object Placement | Prefix | Sufix | Precision | Farmat hame | |
Regular Stationz B Station Clut 012 THEEE.EE

- LCardinal Stations

B

- Station Equatiohs
Ewent Points =lp
Radius + &
Tranzition Aadi ¥ Display Curveset PI

Wertical Stations
[ Display Individual Element Pl

Display Or: % Multiple Lines € Single Line

Leaders: Hel
| Ohject | Length |.t'-‘mgle | Relative Ta|Mame | | Ll

Leader Line
[ Segment 1 | 0.0250 07°00'00.00" | Aligrmest
B Segment 2 | 0.0800 0°0000.00" | Alignment

Apply Preferences. . Close Help | J Help
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Geometry

TEdit / Review Extended Description ;Iglﬂ
M ame: |-| j ﬂ Apply |
Dezcription: I Cloze |
. . L | structure = -_EI en Lirk...
e Cogo Points Extended Descripti o
N EX te n d e d D esC ri pt| on ™3 HWY 20 K Bracing 1.1PG - Windows =10f ]

— Linked File

=101 x

e Chain Points

Puaints; I Apply |

- H O rl ZO n ta | S EEEEED Cloze |
I arme | Descrip... | Style | -
—_— 479 BOUMD... Filter... |
Features 478 BOUMD...

438 Default  Hep |

348 Drefault

339 Default  —

323 Drefault

153 Drefault LI

Create: ¥ Huorizontal [ Featue

M ame: IEHisting Center Line

Descrption: |tram 1043108 Survey

Style: I Drefault j
B andwidth: |1 000

|t | X 2 W@

[~ Create as a Closed Alignment or Feature
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Geometry Functionality

e Enhanced Compound Curve Sets
— Horizontal Curve Set > Insert PI
— Horizontal Curve Set > Move PI
— Horizontal Curve Set > Delete PI
— Horizontal Curve Set > Define Curve Set
— Horizontal Element > Edit
— Horizontal Element > Move

e Tools>Options>Geometry>Transitions
- Removed from tools T G

e Vertical Alignment Healing
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Geometry Functionality

e Cogo Audit Trail

e Traverse Edit>Maintair =

e: Add teo Cego Buffer

*#%+ Mpdified by Richard.Bradshaw on 1/9/2008 11:14:35 BM

—347.403 325.708 0.000

—347.403 225.708 0.000

o Simultaneous Tracking _ ‘===

rse Directicn

e Inverse Direction

H 26+45'09.4" E 158.726

-378.299 217.323 0.000

. D e S i g n C h eC kS e -378.2959 217.323 0.000

|

H 70~48"'53.4" E 103.2138

. Ad d FI O a ti n g C u rve e -344.37% 314.30%8 0.000

-344.37% 314.30%8 0.000

e LandXML Geometry Ale "™

Dynamics Settingz and Intervals

[ Station: IEI.EIDEI

e A IOt more..... I Elevation 0000

—
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Survey

e Single Point Curve Contrc ..

o Fvitoandad Nacrrintinn

e Empty Fieldbook

e Random Points as Separate Feat

Edit Style

R —

Description | &lpha | Mumeric
Faint of Curvature PC 3
Faint of Tangency PT 4
Exclude from Triangulation DMC 5
Random RMD B
Rectangle RECT Maone
Cloze Rectangle CLSRECT 7
Hontangent Curve MT a
Join Point JPT MHone
Join Mearest Code JMC MHone
Diztance DIST MHone
Template TMPL Mone
Crogs Section X5 Maone
Add to Adjustment Set AL Mone
Extend Arc ExTARC MHone
Single Paint Arc SPC Mone

[ su

Froject Mame: Ii,:,b-| 23

=~

Description: |Use attributes

[

B

Apply |

Cloze |

Curve Shoking: IH::urizu:untaI and Yertical j Filter |

Duplicate Mames: % Feplace

i~ Rename
[ Empty Project

Preferences. .. |
Help |

Build Extended Dezcription
Irsert:

Attribute M ame
Attribute Walue
Code

T Ed

M arme:




Survey

e Survey Style Filter>Point Range

e Survey Data to Geometry. Multi-coded points
that are in multiple chains can now be sent to
the geometry project creating only one point for
all chains and using said point in all chains

e Survey Graphics DNT Tag
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Survey

e Support Trimble DC Codes: B6, 69CC, 69TM,
90, 91, and 92

e Translators > SDMS Translator has been
improved

e Automatic Update of Surface

— Wiew Optionz
v Automatic Refresh

v automatic Update of Surface
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Survey- Variable Manager

e Use Spaces in Surface Description

— Use spaces instead of commas when separating
attribute values in the surface description of features
created through Survey > Survey Data to Surface

e Swap Trimble DC Coordinates

— Swap the northing and easting coordinate columns
during a Trimble DC import

e Trimble DC Import

— During the Trimble DC import, ignore all 13TS lines.
These lines are timestamps and by default are
imported as notes. Also, ignore certain 13NM notes as
defined by Maine DOT

= Bentley




Surface Enhancements

e Performance

e Import Enhancements
- From Graphics

— LAS Format
e InRoads Site & InRoads Site Suite
e Available in AutoCad

e Export>Surface to Geopak DAT file

==l
Surface: I original j g ave_l
Fence hode; ||Eln'2'f3 j Save As... |
Paimt Drder: |Easting, Marthing, Elevation ﬂ Cloze |
Poirt Type:  [GEOPAK DAT File e
Ferm Order: IElne then Zeroes j

. Pref
[ Ewport Triangles [EIerEnees

i

File Mame: Help

IE: WRIOEWProduct b anagementh 2008 Conferences
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Surface

e Feature Properties
- Edit Style Button
— List will Hold position

.-'-‘..Feature Properties

o]

Surface: I|_93 j —Stylg Apply |
Avallable:
Feature: ['_<15_Bottom a Close |
Name [ style | Desciiption [<] #| | |0 a3 henter ﬂ ;
FPU E_TOPO_Eraakl.. D_AxI5_Leit (S
P E_TOPO_Braakl.. D_AxIS_MajorTick .
F P E_TOPO_EBreakli.. D15 _MinorTick Edit Style.... |
FF E_TOPO_Breakli... D <15 Right
P2 E_TOPO_Braakl.. N P
- - . . [ et |
FPW3 E_TOPO Breakl FPrimary |
E TOPO Er E_TOPO_Breakline i Lizt Paints... |
PP E_TOPO_Ereakli -
P2 E_TOPO_Braakl.. Help |
HFFY E_TOPO_Braakl.. 1
PP E_TOPO_Braakl..
HFFZ E_TOPO_Braakl..
HFFZ1 E_TOPO_Braakl..
HFFZ2 E_TOPO_Breakl..
HFR0 E_TOPO_Breakl.. - Pay ltems
PO E_TOPO_Braakli.. Name | Description | From Style |
PO E_TOPO_Breakl..
HFO2 E_TOPO_Breakl.. E
HFO3 E_TOPO_Breakl..
D4 E_TOPO_Breskli..
HFO41 E_TOPO_Breskli..
HFOS E_TOPO_Buiding |
Marne: IXFF‘X r~ Triangulation
Description: I Feature Type: IBreainne vl
Parent I Faint Denzity Interval: ID.DDDD ﬂ

¥ Refresh/Display in 3-0/Flan Yiew

[~ Exclude from Triangulation
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:-:Delete Triangle

=101 x|

Surface>Edit Surface E

;Merge Surfaces

Surfaces
Original: I 1-93 j
--g Transform Surface

® Delete Triang Ie By Filte rS Original Surface: I|_93

[

Destination Surface: IDefault j

e Transform Surface e [ ]
Fence Mode: IInside j

— Accepts Negative Value s

| o~oooo”
Source|  Horizontal Seale: |-|_|:||:||:||:|
e Merge Selected Areas  wew[wmasss o
Clip B T el |

e Copy Portion of Surface>__~ '™ ¢

Features:

W

"’| Apply

=10l ]
Cloze
Filter...
Freferences...

Help

. bl

[x

Apply
Cloze
Filter...

Besultz...

—_ CI I p FeatU reS — D ezcription

Duplicate Mames:
i tppend © Feplace  © Fename

ddidd

Help

1+




- Drainage Lay Out ) ]
Drainage and Utilities A WP B
-z Edit/Review Pipe B =1o] =]

Pipe |Ston'n Flow I Sanitans Flow] Desig'nll HGUEGLI User Dﬁta.l Styles I

Slojxi| __tee |

Evaluation Modeler  Drafting Tools Help |

S T R

e Graphical Picks i

. La O u t Pump | Inlet I Gutter Section I Area I Zone l Design
y General I Structure |Ds | Pipe ! Channel I Cubvert ! Manhole
Drainags Structurss:  [£4P09-Evaluating Drainags Design'i_stuicturss dat

- Edit/Review B P————

{ £ galdmin

e Structure ID’s Visibl

— Status
& Fxed € Resize

e Planarize Option b

¥ Plananizs
Elevation: §1 00,0000

Aosly | Preferences.. | Glose | g Bentleg




Drainage and Utilities

e Report on Station & Offset
- Pipe
— Culvert
— Channel

mResults =lolx]

b

) o Cloze I
Drainage Reports —
Element Twvps: Fipe _JEEEE;;J
Date: Momday, Octoher 20, 2008 10:54:44 S
Drainage Data File: Highway alt 1 “ Print |
I Planlength Liameter Haterial Station Up Dff==t Up Station Dn Offzet Dn Help |
it {in}
P1 61.03 24 .00 Concrete 121+85.00 -25.00 122+20.00 25.00
P2 35 .3k 24.00 Concrete 122+20.00 25.00 121+85 .00 30.00
B3 167 B2 24.00 Concrete 143+33 .19 —62 63 142+30 58 70 .16
P4 10 .54 12.00 RC C76-A T29+8T. 080 =T 29 +59 .65 =g 71
PG A8 85 2400 RC C76-A 144450.10 -22.17 143+81 25 -22 .15
P8 22.09 12.00 RC C76-A 129459 65 -9 71 129+59 4% 12.39
P9 15449 12.00 REC C76-4 129459 .65 -9.71 129471 .22 —-20:11
P10 14.07 12.00 RC C7e-4 129459 . B5 =9.71 129+71 .95 —2.81
Pl1l 12 .30 12.00 REC C7e-4 129459 65 -9.71 129+61 45 -21.88
P24 1e6d &7 12.00 RC C7e-4 146405.78 44 .08 144+40.10 48 .26
P32 109,93 18.00 RC C7e-4 147456 .36 —-22.11 146+47 74 —-39.03
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- - H - - Edit/Review Pipe il =|Of %]
Dralnage and Utllltles Fipe I'StormFlowl'San'rtawHowlDesignI'HGL.-’EGLiUserD

' No Display Help |
Uﬂlﬁ)’ l Uzer Biatd Inside: I ;I

Lﬂﬂi‘l}’. IEF: ||_J Pipe Inside Crossing
® StYI eS Lttility Mame: I_E e | =]

: Mo Display
Feature Ste: F '

- Read only e
- Notes i

Height:

e Edit/Review Utilities T |

e
Faint I{l'i

Y ——

el esl o]

[ Certer View

Morthing: ’2[?251
Easting: |2J3523
Elevation: Iﬁ-gg_?

~Back
Length: [12¢

Direction: iSZE oy | Cose | Edilip, | EdiDown.

Slope: !ﬁ e ] R [055%
Hevation: 538 5000 Elevation: 538 8750
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Drainage and Utilities

e View>Drainage As Solids

| e rfo rI I Ia I lCe File e [Diainage Suvey  Evaluahon Modeler Drafting  Quantities
<Unnamed:

Tools  Help

CEE|SNY H= w07

| - Pipes

Struckure Type I Total |
T Areas i
il Channels n
Bl cubverts ]
= Inlets 1]
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Create Template

e Enhancements
- “Athens” Focuses on Usability

.....Bottom Line
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Create Template

e Create Template>Active Template

— Icons for Components & EC’s o 5453 Poins
i B dard component
- PO I n t CO | O rs r— Current Template
. Ela Components - Mame: ISiderDad
- Pa re n t/C h I | d CO m p O n e n ts : t::fﬂ Description: IPnints have labels ta control widths, depths, ete.
- DISpIay Controls : Lo
= Lous :

..... = LFilz LCyp Edib..

..... = |Fill3 w Oyt Delete  DEL

----- ezzy Lhiedian = | Oyt Rename F2

----- gy || pper Shoulder Layer ] LDt v Displayed

[+-B2m Pavement

E|.--i::_:: FBaze?
tetize AlUpper Shoulds
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Create Template>Active Template

— Parametrics Constraints

— Altarnatpa Siirfarac

------ =+ RUpper Shoulder Layer
----- ] Display Rules
f-/_7 Paramatric Constraints
o Altemate Sufaces

[#1-€23 Machine Control

| Walue

E-4 Alternate Surfaces
5 I Delete  DEL
Rename F2

= Bentley




Express Modeler

e Station Limits |

. . Horizantal Alignment: ashingtor - | &
- InRoads Site Suite L =13

Yertical Alighment: I'W'ashingtl:un j
—_ InRoadS Interyal |1|:|_|:||:||:||:| ﬂ

e Access Roads .
e Driveways Start: [0400.00 +|
Stop: [17+39.65 +|

=1 Bentley




Roadway Designer

& Roadway Designer - C:\$J0E\ Training! Client Specific\MnDOT & Designer\MN_DOT.ird
File: Corridor Superelevation Tools

20 A | o

=181 x|

Closs Help

t=AaH-tOudi| | : :
Corridor:

[i} T Bl d
P =4
THES = Statior: ﬂﬂ IBDD+UU [il] jﬂﬂ Display Superelevation
Aotive Suface |—‘de2031 18 clp vl Interval |1 0.00 Process Al
Template:
[T 88 Sheuiders orl Frocess Yisibls Fange
A
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Roadway Designher

e Set Corridor Active
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Parametrics Constraints

- = z
a Parametric Constraints

§  Coridor: THES [~ Statior Limitz
Skart:
Constiaint Label [,e1ing = art: {300+00.00 ﬂ
#|

Skart ' alue: I_D_1 7 atop: |83?+EIEI_EIEI

Stop Value: |.|:|_1 7

I Overnide Values:

| Start Value | Skart Station
eI
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Point Control

Al E—

|

= i~ Statian Limits |
# | sten 780+00.00 +||

Vertical Alignment. | escp z

[~ Lse as Secondary Alignment

Pricrity: 11

Horizantal and Vertical Contrals:

Harizontal Alignment: |55 b _J

5 Start; {000 ﬂ :
Stopt {0.00 +|

[ Mertical Offsets———————
Start: {000 ._ti
Stop: .00 +|

o
I

Close

.' Help

tdode il |
€ Hozontdl € Vertical & Both Stop. [854+93.80 iii _ Chenee |
Caritrol Type: Aligrmert 71 1 Horizontal Offsets

700+0000  911+60.00
801+04.74  BO0B+59.64  Horizontal

Mode
0 h ghment
Alignment
Alignment,

ath
Both

BEME:BSMB

SER-ROEP =
| »

+=LAH-TE A

Corridor: THES = Station: HJ Er jﬂﬂ

Active Suface: pd0208118_clip - Interval 10.00
Template: T.H. 65 Shoulders arly

Delete

Close: i Help

-
»
Dizplay Superelevation
Process Al
Process Visible Range

4 Bentley




Display Superelevation

yay L

Controls

Coridor: . proposal 1

Por R

~ Station Limits —————————

Start: [10+000.000 +

Muode
‘(' Hozontal O Vertical € Both

Stop: [11+612.980 |

Control Type. Superelevation &
Superelevation Section] CLREF =

Reference Paint. [ i

& Priarity: 1

Harizantal and Vertical Cantrols:

~ Horizontal Offsets

- Vertical Offsets

Change
Help

[ Contral

[En.. [ Fii.. [ Hame | Start Stati.. | Stop Stati.. | Mode | Tupe
1 LEP 104000,000 114612980 Vettical Superelevat
00 5 k L

REP 10

Conidar: poposal 1 B
Active Surface rﬂfigmal—:']

1146

Section] CL4

Delete

Station:  [¢] | [10+360.000 i+
Interval T T—
Template: Sideroad

Display Superelevation
Process All
Process Visible Fange

e
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Point Control Recap

Cantrolled by
Proint control

Highlighted Control line

Cantrolled by
Parametric Constraint

Highlighted Point
indicates controlled point

Highlighted Control line

= Bentley




Tepl

/

ate Transitions

X,

=10l x|

Ldd

Station: {118+20.00

Interal: |-| 0.00 ﬂ
Library Templates;

7 C:AJOE\TrainingsClient SpecifictnDOT & Desigherstb_DOT it

Cloze

Change

Copy

Edit

Deleke Help

[ G |
e
e
[

Add Transition

Current Template Drops:

Skation | Interal | T emplate | Enable Transition | Revized In | Library |
114+438.64 10.00 Iyzzes St M, ITL Chauppart logsiDericke Gra...
116+00.00 10,00 Iyzzes St ITL CARIOENTrainingsClent Spe...
124+00.00 1000 Iyzzes St IRD C:Azupport logztDericke Gra...
12743513 1000 Iyzzes St IRD Chzuppart logssDericke Gra...

Synchronize with Library Edit | [lelete

E_
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Template Transitions

e Intelligent Transitions
- Template Synch
— Ability to Add Transitions to Copied Templates
- Warning Dialog

Rerninder =

In order for the transition to work properly, the appropriate
constraint(s), on points that are transitioning, must be removed.

|| Don't show this message again

= Bentley




Enhanced Super & Rollovers

* Instantaneous Shoulder Rollup Transition Option

— Specified Length x|
.. Shoulder Paint: LG tter j & -
— Match Transition Slope e 4
. . - Hioh Side : 4|Hel
e Non-Linear Transition Difeerce: o000 [ ]

[ Masimum Slope: ID.UDDZ

Mame:
. Inztantaneous Shoulder Bollup Transition Option

Station: -

¥ Specified Length: IEI.EH
Crozs Slope:

i~ Match Transition Slope
Type:
Mon-Linear Curve  — Low Side

Difference: IEI.I:IEIEIZ

~Constraint:—— | [ Minimum Slope: IEI.I:IEIEIZ

[
Type: |H.:,,i; ~ Limits
Farent 1: Iﬁ [ Station
Start |100+00.00

Stop: [116+12.98

|+ [+

W alue: 0.00
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Evaluation Enhancements

e Annotate Profile>Template
=loix|
e Annotate Feature = 5] e e ¥

I bazeline | Mame
[ Deflootion N Template: 100.000
- ™ Annotate Feature In Profile _|= 5'
o C Section®] ==
ro S S e C I O n Profile Set: Jusztificahion: ITUI:' Left j JJ
[ . | _J:_I . . . . . .
errer— oI5 fian_| Fomat

® Fe a t u re & St r = Create Cross Section ¥ Single Sheet Each Madel

..... Fer=r=l

..... PO oot Cross ecton —————— S
""" Irvcl - Cross Seclion Set Mode: ¥ Refiesh (" DisplawOn " Display Off e
% E':'” [ baseline =1 # s 10000000 Stop:  11+612.980 sebes oo
us B
425 Law Update Cross Section Lirnits

% General " Station Range

Surfaces

Start: =
Components At 10+000.000 lﬂ
Crossing Features Stop: [11+512.930 j‘ ﬂ

Projected Features
Update
IVI_ Annotation
R

Storm and 5 anitary
D Aie ™ Show Features Outside Elevation Rangs
{7 Giid

D Det [~ Display Feature and Structure Bands
et

-3 A8t J Help |

sppy | Cose | Hep | g Be ntlegﬂ




Evaluation Enhancements

e Triangle Volume>Surface Description

e Roadway Visibility
— Report are XML
- Pick Button for Horizontal [

ST — ARUP_CADTools_InRoads - Sight Visibility Diagram

% ré!:?e T Full 88D

A 120 Clearance

2] Custorn 625

21 DataCollction

o |23 Evalustion

H |21 Geomely 500
1 ics

2] Images

1 12 ersestingAlignmentStations 375

o |23 LegaDescripiion ~ N

21 Lightf sibanufacturing

W 12 MapCheck 250 I

12 Obsoete

21 RoadwayDesian f

D (295)

SSD (215)

— |

B

b 120 sehemas 125 A

o 130 sighvisiin \j ~/ U
] Stakeaut

=] Stafionffset 0

2] Superelevation

°] Sufasss

21 survey

21 Tabing

o 50 TemplateLibrary

H = rumous =

241
41
54400

[ Alignment: 00_4L_vis_WB0a_L |

3 Roaduay Visbilty Symbology:

General | Object.

Posiions B0 Desied

% Sight Line | Desired Originater

L Desired Teminator
B Aclased
{0 Related Originator
1] Relaned Temingtor
(] Unacceptable
|1 Unscceptable Diiin

[

i

Sight Line Length:  ¢5) Sight Distance

© Actusl Distance

[ epb | [Preferences ] [ Dlose [
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Drafting Notes Soettings . (o]

Flacement kode: Ciata Point
Flatate By: | 10700'00.0" Cancel |

Scale By: ||:|.-| ann |
—F Inzertz: — Il e MLI
¢ S I O p e FO rm a t S u p p O rt SF - Blignment Mame [Prirmary] ;I
L - glighment Mame [Secondary)
= - \ 144 i
e Vertical Alignment "z - R
- Station
- Plan Note | it ol
. P |ace AI Ig n m e nt | nte rse Ctl O n N Ote | |- i-;":tertical Elevation on Secondary Alignment J &pply |

. . « [» hd Cloze _|
e Place Coordinate Grid Eu—-—-—-- 2|
|Rteral: |2|:|_|:||:||:| ﬂ Lpply | _l

1 1 Dal & niclude Tick Marks
e Draw Slope Direction Patterr === ﬂlu
Preferences...
¢ Update NOtes Note File: IEZ"'.DTEIQTEIN-I"mtlEr'lt|E_'.-"".ir'|rI:lad~1.11"'- J Apply | Ll
- Intersection Notes Ypdae se | f— -]

— Drainage Structure 8 o | —|'”HI

. Elements " Single From Graphic |
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[
XML Reporting

e XML Reports Navigate
— Appropriate Folder
— Opens “"Standard” XSL

e XML Precision Increased to 7 Digits

e Report Browser no longer Require PW Log

« XML Reports > Stakeout

— Vertical Alignment Elevation Referenced
— Station Limits Added
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[
XML Reporting

e New XSL Delivered
— TrimbleAlignmentDC.xsl
— TrimbleStationOffsetDC.xsl
— HorizontalAlignmentReviewStationOffset.xsl
— Sight Visibility>
* RoadwayVisibiltiy.xsl

* RoadwayVisibilityASCII.xsl
* RoadwayVisibilityGraphSVG.xsl

e Enhanced XSL

— ErrorEllipse.xsl
- LeastSquareAdjusted.xsl
— VolumesWithReplacedAddedToNormaFill.xsl
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